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Excel is a staple of the business professional’s toolbox, yet, all too often, features remain undiscovered 
and underutilized, leading to inefficiencies and errors.  Many of these features have been in Excel for a 
number of years and some are new in Excel 2013.  All of them will save you time.  In this session, you will 
learn about key features in Excel and how to put these features to work.  Features such as Data Tables, 
Forecast, Forecast Sheets, XNPV, XIRR and PivotTables.  Among the new tools you will learn about are 
Quick Analysis, Data Models, Flash Fill, PowerPivot, and Power BI. 

Learning Objectives 
Upon completing this session, you should be able to: 
• Identify and implement three types of automated data analyses in Excel; 
• Use Flash Fill to split, combine, and rearrange data quickly and easily without using commands or 
complicated formulas; 
• Utilize Excel’s Data Model and identify their impact on PivotTable analysis; 
• Obtain insights into data using business intelligence features in Excel. 

Ten Best Practices for Creating Financial Models in Excel 
Although the term “best practices” is, in the eyes of many, overused in today’s vernacular, it still has 
meaning when considering how we should build our financial models in Excel. Thus, let us begin this 
session discussing why the following ten items are considered best practices for creating financial models 
in Excel. 

Clearly Articulate the Objective of the Model 
Define and clearly indicate the nature of your model up-front. A good place for doing so is in the Properties 
section of the Excel workbook. By clearly defining and articulating the objective of the model, you are 
letting other users know what they should expect from the model, and, at the same time, you are helping 
to minimize the prospect of “scope creep” affecting your model and causing it to turn into an unwieldy 
and unmanageable workbook. 

Build the Model Using the Least Complicated Structure and Functions 
Simple is good should be your mantra when creating Excel-based financial models. You should always 
strive to create your models using the simplest, most direct techniques. Doing so will allow you to create 
the models more quickly and help you to reduce the prospect of errors arising in your models. For 
example, seek to minimize the use of IF functions in your formulas and try to avoid nested IF functions 
altogether. In many cases, using MAX or MIN functions or the recently added IFS function will provide a 
simpler, more direct approach to creating formulas in your financial models.  

Sufficiently Plan Your Model to Ensure Simplicity and Accuracy 
Following on the previous point, a bit of planning can go a long way toward ensuring simplicity and 
accuracy. Think in advance about what you are trying to accomplish and use this as the basis for creating 
your workbook. A good rule of thumb here is to start with the desired end result and work backwards 
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from there. This will help you to identify all the necessary assumptions and calculations up-front and 
expedite designing your workbook for simplicity and accuracy. 

Clearly Label and Document Assumptions and Perform Adequate Data 
Validation 
To further simplify your workbooks and reduce the opportunity for errors, you should ensure that you 
clearly identify and document every assumption that is in each of your Excel models. Using Excel’s 
Comments feature is a great way to add detailed notes about the source of an assumption. Further, using 
Excel’s Data Validation feature facilitates you restricting end-user inputs to values within prescribed 
norms, thereby preventing someone from entering an interest rate of 0.03% when the correct rate should 
be 3.00%.     

Ensure the Protection of Calculations and Formulas 
In many cases, other team members or perhaps clients will be the end-users of your Excel models. To 
ensure that these individuals do not change any of your formulas, you should enable Excel’s protection 
tools. Among the ones that you should most likely consider using are those listed below. 

• Encrypt with Password to ensure that unauthorized users cannot open a workbook or create links 
from cells in the workbook 

• Add a Digital Signature to reduce the likelihood of unauthorized changes and provide an alert 
that potentially unauthorized changes have been recorded 

• Protect Workbook Structure to ensure that individual worksheets within the workbook are not 
added, deleted, rearranged, hidden, or unhidden 

• Protect Worksheet to control whether a single user or a group of users can make edits to a specific 
worksheet in the model, and, if they can, which cells can be edited and what actions can be taken 
on those cells 

Create a Beta of the Model to Test against “Known-Good” Results 
As you are creating your models, consider building or testing them using historical data. This provides the 
luxury of comparing the results from the newly created model to “known-good” results and helps to 
ensure the accuracy of the model. In what would hopefully be very rare cases, it also potentially could be 
useful in identifying errors in previously generated reports.  

Maintain the Independence of the Workbook Whenever Possible 
While you might exercise caution and due diligence when creating your financial models to ensure that 
they are free from error, can you say the same about others on your team? Because if they do not exercise 
the same level of care that you do, and you link data from one or more of their models into yours, you 
would have created an opportunity to corrupt your model with the erroneous data flowing from theirs. 
Always seek to create independent, self-contained models that do not depend upon linked data from 
other users’ workbooks. If that is not possible, then you should thoroughly examine/audit their model to 
ensure that it is free from error. 
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Understand Your Audience 
Know which team members or clients will be using the Excel-based model that you are creating and tailor 
the design of the workbook and the terminology used therein to their knowledge level, skill sets, and 
needs. A group of accounts payable specialists will have a decidedly different skill set than a CFO. Ensure 
that the model that you are creating aligns with the skills and needs of those who will be working with it. 

Project the Life of the Model 
Some financial models – perhaps one providing a simple present value calculation used in a capital 
budgeting project – will have a very short useful life. Others – for example, a business valuation model 
that is updated quarterly to estimate the value of the stock of a privately held concern – will have a useful 
life that may extend for decades. While both models are important to their users, in some cases, you may 
be able to treat the model with the shorter life a bit more “casually” than the model with an extended 
life. Likewise, if a model is used repeatedly – but with a different set of assumptions each time it is 
accessed – you should consider saving it as an Excel template file (with an .XLTX extension); doing so will 
make it easier to access, enter new assumptions, and save as an independent Excel file without risking 
overwriting the templated model.   

Take Advantage of Continuous Improvement in Excel Features 
Particularly if you use Excel through an Office 365 subscription, you are in an environment of continuous 
improvement with new features being added as frequently as each month. Seek out and utilize these new 
features as they become available to help you build your models with greater speed and ease than might 
have been possible in the past. For example, the FORECAST SHEETS feature added to Excel 2016 (and 
discussed later in this session) provides a great illustration of a new feature that can save countless hours 
when building a forecast that needs to reflect seasonality in your data. 

Sensitivity, Trend, and Discounted Cash Flow Analyses 

The Need for Sensitivity, Trend, and Discounted Cash Flow Analyses in 
Financial Models 
Among the most common needs in Excel-based financial models are sensitivity analysis, trend analysis, 
and discounted cash flow analysis. In the following section, you will learn about best practices to 
accommodate each of these needs in Excel-based financial models. 

Performing Sensitivity Analysis with Scenario Manager 
Sensitivity analysis simply asks the question “what if” and is often used in budgeting and forecasting 
models. As an example, team members might change a sales growth percentage from 4% to 5% to see 
what the impact is on the bottom line. While a simple change such as that one is easily keypunched into 
an Excel model, challenges arise when attempting to track multiple versions of a workbook, each with a 
different set of assumptions. To ease this process, consider taking advantage of Excel’s Scenario Manager 
feature. You can use Scenario Manager to manage and save up to thirty-two different variables quickly 
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and easily on a single worksheet within your model. Further, Scenario Manager can affect multiple 
worksheets, so you can use it to manage up to thirty-two variables on Sheet1, thirty-two variables on 
Sheet2, thirty-two variables on Sheet3, etc.  

You can access Scenario Manager by clicking What-if Analysis on the Data tab of the Ribbon and choosing 
Scenario Manager. As shown in Figure 1, you can add, delete, edit, and merge all the scenarios for the 
active worksheet from the Scenario Manager dialog box. For each cell that you choose to have Scenario 
Manager affect, you can store and save your assumptions in the Scenario Values dialog box. To recall and 
insert all the assumptions for a specific scenario quickly, just click the scenario’s name and then click the 
Show button near the lower right corner of the Scenario Manager dialog box.  

 

Figure 1 - Working with Excel's Scenario Manager Tool 

A very useful feature of Scenario Manager is the Scenario Summary report. Clicking Summary in the 
Scenario Manager dialog box causes Scenario Manager to create a report that shows all the assumptions 
and all the results for all the scenarios on that worksheet. This can be very useful when attempting to 
compare various options contained in your financial models. Figure 2 illustrates a sample Scenario 
Summary report. 
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Figure 2 - Sample Scenario Summary Report 

Using Excel Functions and Features for Trend Analysis 
Trend analysis is a “go-to” technique when attempting to forecast future values based on historical results 
and is often used when building sales forecast, budget, and business valuation models in Excel. Numerous 
options exist for conducting trend analysis in Excel, including formula-based approaches, automated 
approaches with add-ins, and an alternative automated approach added to Excel 2016. Each of these 
methods is discussed below. 

Working with Formula-based Approaches for Trend Analysis 
Excel provides numerous formula-based options for creating estimates of values in future periods. These 
functions allow a user to construct simple formulas on observed data for producing equations useful in 
forecasting future values, such as revenues or expenses. 

FORECAST is used to calculate or predict a value based on existing values. For example, the formula 
=FORECAST(25000,A2:A31,B2:B31) would predict the monthly sales associated with advertising expenses 
of $25,000 one month prior, given the linear relationship between the independent variable in range 
B2:B31 and the dependent variable in range A2:A31.  

TREND generates values along a linear trendline and can be used to predict multiple future dependent 
values based on the relationship between existing dependent and independent variables. Note that 
TREND formulas are array formulas and must be entered using SHIFT+CTRL+ENTER.  

GROWTH is very similar to TREND except that GROWTH provides an exponential calculation rather than 
a linear calculation as provided by the TREND function. Like TREND, the GROWTH function must be 
entered as an array formula. 

Other useful functions that can be used in this same context include LINEST, INTERCEPT, SLOPE, and 
LOGEST. 

Creating Regression Analyses with the Analysis ToolPak 
The regression analysis tool in the Analysis ToolPak add-in allows estimation of a single dependent 
variable based on up to sixteen independent variables. In our first example, a sales executive wants to 
determine if there is a relationship between monthly revenue and advertising expenditures incurred in 
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the previous month. Used here, regression analysis will determine the strength of the relationship 
between these variables and will forecast future sales revenues.  

Consider the partial dataset shown in Figure 3, which summarizes monthly revenue and advertising 
expenditures for the past thirty months. Note the general trend in the data. As advertising expenses for 
the prior month increase, sales revenues for the current month increase. 

 

Figure 3 - Regression Analysis Data Set 

To begin the regression estimation process, click Data Analysis on the Data tab. Then, select Regression 
in the Analysis Tools list of the Data Analysis dialog box and click OK as shown in Figure 4. 

  

Figure 4 - Selecting Regression in the Data Analysis Dialog Box 

In the Regression dialog box shown in Figure 5, click the Collapse Dialog button just to the right of the 
Input Y Range box and select the range of cells that contains the dependent variable. In this case, select 
the range A2:A31, Monthly Sales. Next, click the Collapse Dialog button just to the right of the Input X 
Range box and select the range of cells that contains the independent variable. In this case, select the 
range B2:B31, Ad Expense 1 Month Prior. Note that the number of observations in the X and Y ranges 
must be equal.  
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Figure 5 - Specifying the X and Y Ranges in a Simple Linear Regression 

Click OK to calculate the regression and display the results on a new worksheet as shown in Figure 6. 

  

Figure 6 - Linear Regression Analysis Based on a Single Independent Variable 

When interpreting the regression results, key components to consider are R Square, the Intercept 
Coefficient, and the X Variable 1 Coefficient. Recall that R Square is a measure of fit – it measures how 
well the computed linear equation fits the data. Generally, an R Square value of 0.80 or higher means that 
there is a strong relationship between the independent variable(s) and the dependent variable. In this 
example, the R Square is calculated to be 0.9118, which indicates a strong relationship between the 
variables and that the linear equation fits the data very well. 
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The Intercept Coefficient and the X Variable 1 Coefficient are used to specify the equation for estimating 
or predicting new values of the dependent variable based on specified values of the independent variable. 
In this case, the equation for estimating monthly sales as a function of the advertising expense incurred 
in the prior month is as follows. 

Monthly Sales = $10,538 + (85.179 * Ad Expense 1 Month Prior) 

To forecast the sales revenue for a future month based on anticipated advertising expenses of $25,000 in 
the prior month, simply substitute the anticipated advertising expenses into the equation and solve for 
monthly revenue. 

Monthly Revenue = $10,538 + (85.179 * $25,000) 

$2,140,013 = $10,538 + (85.179 * $25,000) 

In this case, the regression equation yields estimated sales revenue of $2,140,013. 

Building Trend Models with the Forecast Sheet Feature 
A feature added to the 2016 release of Excel is Forecast Sheets. With Forecast Sheets, you can build 
forecasts into the future that accommodate seasonality in your data. Forecast Sheets examines the dates 
in your historical data, relates them to the actual values, and then creates a forecast for future values 
based on any date-oriented trends it identifies. Further, Forecast Sheets provides you with the 
opportunity to create not only an estimate for each forecast period but also upper and lower confidence 
intervals based on criteria that you specify. 

To create a Forecast Sheet, click anywhere in the data range from which you want to build your forecast, 
go to the Data tab of the Ribbon, and click Forecast Sheet. Upon doing so, Excel generates the Create 
Forecast Worksheet dialog box. There, make any necessary adjustments to the options presented and 
click Create to create the Forecast Sheet as a separate worksheet in the workbook as shown in Figure 7.  
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Figure 7 - Sample Forecast Sheet 

Working with Excel’s Capital Budgeting Features and Formulas 
Many financial models are built to determine the feasibility of capital projects, such as purchasing a new 
piece of machinery or investing in a new line of business. The decision to make such a capital investment 
should always be supported by a thorough Discounted Cash Flow (DCF) analysis. A DCF model involves 
projecting future cash flows and discounting these cash flows back to the present using a discount rate 
that accounts for the estimated riskiness of these cash flows. Finance professionals are in almost 
unanimous agreement that using Net Present Value (NPV) analysis is the best way of creating a DCF 
analysis; however, other techniques such as Internal Rate of Return (IRR) are often used in lieu of, or in 
addition to, NPV analysis.  

Calculating the Weighted Average Cost of Capital 
When preparing a DCF, you should always discount cash flows using the company’s Weighted Average 
Cost of Capital (WACC), not the company’s incremental borrowing rate or any other discount rate. WACC 
provides a risk-adjusted measure of how much of a return an investor would require to loan to or invest 
in a particular company. Because the cash flows of the entire enterprise would be used to repay these 
investors, it would be improper to segregate the cash flows of the project under consideration and use 
only those cash flows when conducting a DCF analysis. Instead, a company’s WACC should be used 
because the WACC measures the perceived riskiness of all the cash flows of the company, not just those 
related to a specific project. 
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To calculate WACC, first identify the company’s cost of debt. Because the tax deductibility of interest 
expense provides a benefit to the company, the cost of debt should be multiplied by a factor of 1 minus 
the company’s marginal tax rate to calculate the after-tax cost of debt. To illustrate, if a company’s cost 
of debt is 6%, and its marginal tax rate is 27%, then its after-tax cost of debt would be 4.38%, calculated 
as follows. 

6% * (1 – 27%) = 4.38% 

Once you have calculated the company’s after-tax cost of debt, then you should calculate the required 
rate of return of the company’s shareholders. This is often done by using the Capital Asset Pricing Model 
(CAPM), which estimates the required rate of return on a company’s stock as being equal to the expected 
risk-free rate of return plus a measure known as “beta” multiplied by the overall expected rate of return 
of the stock market minus the risk-free rate of return. Beta is a measure of the volatility of a company’s 
share price relative to the volatility of the stock market taken as a whole; the share price of a company 
with a beta of 1.0 would move in lockstep with the market, whereas the share price of a company with a 
beta of 2.0 would be twice as volatile as the market. Assuming a company has a beta of 1.2, the current 
risk-free rate is 3%, and the expected rate of return on the stock market is 10%, the calculated cost of a 
company’s equity would be 11.4%, calculated as follows. 

3% + 1.2 * (10% – 3%) = 11.4% 

Knowing both the cost of equity and cost of debt, you are now ready to calculate WACC. To do so, simply 
determine the weighted average of these two components, using the total market value of the company’s 
equity and the total market value of its debt as the basis for calculating the weighted average. In other 
words, if the total market value of the company’s debt is $2,100,0001, and the total market value of the 
company’s equity is $4,800,000, the WACC is 9.26%, calculated as follows. 

Market Value of Debt  $      2,100,000  30.43% 4.38% 1.33% 
Market Value of Equity          4,800,000  69.57% 11.40% 7.93%  

 $      6,900,000  100.00% 
 

9.26% 
 

Simple NPV Analyses Using WACC 
With the WACC now estimated, you can begin performing your DCF using Excel’s PV, NPV, or other 
appropriate functions. However, you should be aware that obtaining accurate results when using the NPV 
function can be a little trickier than many believe. To illustrate how to utilize NPV, consider the following 
circumstances. Carlisle Manufacturing is considering investing in a new piece of equipment that will cost 
$110,000. It projects the cash flows resulting from this piece of machinery to be $18,000 at the end of 
Year 1, $22,000 at the end of Year 2, $31,000 at the end of Year 3, $37,000 at the end of Year 4, and 
                                                           
1 Experienced financial professionals understand that the market value of a company’s debt can fluctuate just as the 
market value of its equity can fluctuate. When estimating the WACC, market values should always be used for both 
debt and equity. 
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$39,000 at the end of Year 5, at which point Carlisle will retire the machine; the company expects to 
receive no salvage value. The Company’s CFO generates the NPV analysis pictured in Figure 8 and 
concludes that Carlisle should not make the investment because the NPV of the project is negative. 
However, the CFO fails to realize that the NPV calculation is incorrect, jeopardizing the quality of her 
decision. Excel’s NPV function calculates the sum of the present value of a series of cash flows and, in 
doing so, it assumes that all cash flows occur one year into the future beyond their actual date of 
occurrence. In the example presented, Excel’s NPV function incorrectly assumes that the initial $110,000 
outflow occurs one year into the future, the $18,000 cash inflow occurs two years into the future, etc. 
This means that all cash flows receive an extra year of discounting and leads to an incorrect calculation. 

 

Figure 8 - Incorrect Version of NPV Analysis 

If you are going to perform an NPV analysis, you can solve the problem outlined in Figure 8 by simply 
moving the reference to the “Time Period 0” cash flow so that it is not part of the NPV function. This is 
demonstrated in Figure 9. With the reference to cell C3 stated outside the NPV function, it is not being 
discounted at all, and each of the other cash flows referenced by the NPV function are now being 
discounted for the appropriate number of periods. While in this case, the decision made by the CFO was 
still correct because the correct NPV was negative, you can clearly see that it would be relatively easy to 
create an NPV model that leads to an improper decision, thereby destroying organizational value. 
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Figure 9 - Corrected NPV Calculation 

Perhaps a better choice when generating NPV analyses would be to utilize Excel’s XNPV function instead 
of the NPV function. With XNPV, you can state the actual dates of when cash flows are expected to 
materialize. Not only is this perhaps a clearer and more discrete way of creating your models, but it also 
facilitates including cash flows that do not occur at symmetrical intervals, such as yearly, quarterly, or 
monthly. To illustrate the usefulness of the XNPV function, consider the model pictured in Figure 10 (with 
some of the rows hidden for presentation purposes). In this example, numerous inflows and outflows are 
occurring over a two-year period at uneven intervals. With XNPV, we can accommodate these irregular 
intervals by explicitly stating the expected cash flow dates in column B and including a reference to that 
column in the formula that includes the XNPV function.2 

                                                           
2 You should be aware that Excel also provides an XIRR function to calculate the Internal Rate of Return when a 
project’s cash flows occur at irregular intervals. 
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Figure 10 - Using Excel's XNPV Function to Handle Cash Flows at Irregular Time Intervals 

Business Valuation Models Using DCF Analysis 
The previous examples of using DCF focused on single projects and determining whether an organization 
should undertake these projects. Let us now consider the idea of using DCF analysis to estimate the value 
of an entire organization. At the risk of oversimplifying, this process boils down to five steps. 

1. Estimate the organization’s WACC. 
2. Estimate Cash Flows for the near term (typically five to seven years). 
3. Estimate Cash Flows into Perpetuity. 
4. Discount All Cash Flows using the Weighted Average Cost of Capital. 
5. Sum the Discounted Cash Flows to Arrive at the Gross Value of the Organization. 

For purposes of this demonstration, we will continue using the WACC calculated in the example discussed 
beginning on page 10 and proceed directly to the topic of estimating cash flows for the near term. As 
pictured in Figure 11, this process generally involves estimating four items: 1) revenue; 2) earnings before 
interest, taxes, depreciation, and amortization; 3) earnings before interest and taxes; and 4) depreciation 
and amortization. 
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Figure 11 - Estimating Selected Operational Data in the Near Term 

Once you have estimated the items indicated above, you will need to make similar estimates for balance 
sheet data, such as accounts receivable, inventory, and capital expenditures. Figure 12 presents an 
example of how these estimates might appear. 

 

Figure 12 - Estimating Selected Balance Sheet Data in the Near Term 

With the estimated operational and balance sheet data available, you can proceed with estimating the 
free cash flow build up that is expected to occur over the near-term planning period. You can do this by 
building a model like the one pictured in Figure 13. This model takes the estimated operational data along 
with the estimated changes in selected balance sheet components and combines them to generate an 
estimate of after-tax free cash flows. These cash flows are then discounted using the WACC, and those 
results are summed to generate a total of the present values of the free cash flows during the near term. 
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Figure 13 - Estimating the Present Value of Free Cash Flows during the Near Term 

Of course, cash flows will materialize after the forecast period also, and these are typically referred to as 
the terminal value. As with near-term cash flows, you will need to estimate the terminal value and 
calculate the present value of the terminal value. To do so, first estimate a long-term sustainable growth 
rate for unlevered free cash flow occurring beginning in the year after your near-term forecast ends. In 
this example, we will assume a long-term sustainable growth rate of 3% beginning in year 2024. Then, 
multiply that rate plus one by the unlevered free cash flow of the last year in your near-term forecast. In 
this case, that would yield $1,169.71 as calculated below. 

$1,135.64 * (1 + 3%) = $1,169.71 

Next, calculate the undiscounted terminal value by dividing the amount calculated above by the WACC 
minus the long-term growth rate. In this case, that yield $18,685.46 as calculated below. 

$1,169.71 / (9.26% - 3%) = $18,685.46 

Finally, calculate the present value of the terminal value by discounting it at the WACC but keep in mind 
that this calculation should occur as of the end of the near-term forecast period. Therefore, the formula 
to calculate the present value of the terminal value would be the following. 

$18,685.46 / (1.0926)^5 = $12,000.46 

Knowing that the present value of the near-term cash flows is $4,177.87, and the present value of the 
terminal cash flows is $12,000.46, you can simply add these two values together to arrive at the estimated 
gross value of the organization, which in this case would be $16,178.33. From this amount, subtract the 
net amount of debt (which is calculated as debt minus cash), and you will arrive at an estimate for the 
total value of the company’s equity. In this case, the net debt is $2,015.0, which yields an equity valuation 
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of $14,163.33. Assuming there are 600 shares of common stock outstanding, each share should be worth 
approximately $23.61 based on this valuation. 

One Final Thought on DCF Analysis 
One of the biggest challenges when creating a DCF analysis is to ensure that the proper basis of cash flows 
– real or nominal – is used consistently and without exception throughout the model. In fact, it does not 
matter which basis is used, because if the same basis is used consistently throughout the model, you will 
get the same result as if you had used the other basis. Thus, the focus on the basis should be consistency. 
One way of checking to see if you have used a basis consistently is to build your model using real cash 
flows and discount rates and then rebuild it using nominal cash flows and discount rates. If you have used 
these bases consistently throughout both models, you will get the same result. 

Excel has three Tables 
Excel now contains three tables that can be of great benefit to accountants.  Two tables were added to 
Excel 5.0 in 1993.  The third table was added to Excel in Office 2007.   The first two, Data Tables and 
PivotTables, were actually part of Lotus 1-2-3. Microsoft followed, enhanced both, and added the third 
Excel Tables to Office 2007.   

Excel’s three tables: 

1. Data Tables 
2. PivotTables 
3. Excel Tables 

Each table has its own distinct value.  Don’t let the title, “Tables”, fool you; they are not similar in any 
fashion. 

Despite being part of Lotus 1-2-3 and the early versions of Excel, Data Tables and PivotTables were very 
unique and very misunderstood for years.  PivotTables are now becoming popular while Data Tables are 
still hardly ever used correctly.  The third table, Excel Tables, is new enough that users do not think that 
they are anything more than formatting, but they are wrong.  By the end of this session, you will 
understand how to use each of these three tables in an appropriate fashion. 

The primary function of each table is as follows: 

• Data Tables  One or two variable analysis 
• PivotTables  Summarize and categorize data 
• Excel Tables  Control a block of data 
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Using Data Tables for Sensitivity Analysis 
One-variable and two-variable data tables have been a major spreadsheet analytical tool since Lotus 1-2-
3, but for many accountants, data tables have become a lost art. Data tables are an excellent method of 
conducting sensitivity or what-if analysis. In a simple one-variable data table, one variable is manipulated 
in calculating a result. In a two-variable data table, two variables are manipulated in calculating a result. 

Many users only use Data Tables to replicate formulas.  This type of use is not all that beneficial.  
Accountants who understand Data Tables know they can use them in analyzing large models to provide 
summaries of complex calculations based on one or two variable changes.  The value of the Data Table 
analysis is directly related to the size or complexity of the calculations used in the tables.   

For example, changing COGS based on a lookup function of values that is driven by activity.  There is no 
way to simply create a formula for all the possible effects of activity without a Data Table summary. 

Simple Formulas 
In our first example, Debbie Nelson, the CFO of a small manufacturing company, is trying to understand 
the impact of a change in unit sales price on the total sales revenue expected from a new product to be 
introduced in the coming year. Her analysis can be done quickly and easily with a simple one-way data 
table. In the example table, the planned sales volume and unit sales price are known. However, Nelson 
would like to calculate the sales revenue generated by unit prices ranging from $6.50 to $9.00 per unit in 
twenty-five cent increments. First, create a workbook with a layout similar to the one displayed at the left 
in Figure 14. Put the alternative prices in a single column, in this case in cells C11 through C21. Build a 
formula in cell D7 to calculate the estimated sales revenue from the planned sales volume and unit price. 
In a one-way data table, the formula at the top of each column of the data table area is recalculated for 
each of the values in a single variable, in this case unit sales price. Multiple columns can be recalculated 
but only on one variable. 

To create the data table, highlight the range C10:D21 and select What-If Analysis, Data Table from the 
Data tab of the Ribbon. In the Data Table dialog box, click in the box for the Column input cell and then 
click on cell D7. This process indicates to Excel where it is to substitute the values $6.50 through $9.00 in 
recalculating the total sales revenue. Click OK to produce the data table shown in the lower right of Figure 
14. 
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Figure 14 - Creating a One-Way Data Table to Calculate Sales Revenue from Multiple Prices 

Multiple Answers in a Column (Row) Data Table 
You can use as many available rows as you have in your worksheet for changes in the variable and as many 
available columns as answers.  If you create a Data Table with a row of variables, then the above rules flip 
and you can use as many available columns for the variable and as many rows for the answer.  This option 
becomes very powerful.  We can change the interest rate and find out three answers:  Payment, total loan 
interest, and total payments on loan. 

Given Excel 2007 or Excel 2010, Data Tables can become a very powerful tool because you now have over 
sixteen thousand columns and over one million rows.  See table of features below: 

Copyright © 2018 K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises training event is prohibited. 
18



 

 

 

A Greater Value 
A greater value can be found by using Data Tables in combination with complex calculations that cannot 
be done in a single cell.  For example, you can easily create a simple formula to calculate a loan payment.  
=PMT(rate,nper,pv).  Using at Data Table when you can easily create a partially absolute formula is not all 
that helpful. 

Using the loan amortization analogy, you would need a Data Table to compare total loan interest with 
different rates as the variable.  Without the Data Table, you cannot easily compare a column of rates and 
the total loan interest which requires the body of the amortization in the worksheet which calculates this 
answer.  Hence, the more complex the answer, the more valuable the Data Table analysis.  Companies 
with large financial models can reap great insight from using Data Tables with key variables on large 
calculations. 

Analysis of Interest 
To create the two-variable data table, begin by creating the outline of the data table as shown in Figure 
15. Note that in the outline shown, cell Q3 contains the formula =PAYMENT.   

 

Figure 15 - Outline of Two-Variable Data Table 
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Once the outline of the two-variable data table is complete, select the range from cell Q3 through cell 
X13. Then, from the Data tab of the Ribbon, select What-If Analysis and Data Table to open the Data 
Table dialog box shown in Figure 16. In the Data Table dialog box, enter cell H7 as the Row input cell and 
cell H8 as the Column input cell and click OK.  

This instructs the data table to substitute the contents of the first row of the data table into cell H6 and 
the contents of the left-most column of the data table into cell H8 and to recalculate the formula in the 
cells. 

 

Figure 16 - Data Table Dialog Box 

 

Named Cells 
A more useful approach when creating Data Tables is to name the cells of key variables so that during 
Data Table construction you can reference the named cell and not worry about specific cell addresses. 
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Excel Tables  
The table features in Excel 2007 and Excel 2010 are designed to ease and enhance the way users sort, 
filter, format, and analyze information in tables. Here are some of the built-in features for managing and 
manipulating tables. 

• Auto Expansion – Tables expand automatically to include new data entered in adjacent rows or 
columns. All styles, calculations, data validation, and conditional formats are applied to 
extensions. 

• Sorting – Users can sort on unlimited columns and on font or fill colors. Sorts can be made case-
sensitive. 

• Filtering – Users can filter on single or multiple criteria, icon sets, and on dynamic dates, such as 
last week or last month. 

• Formula Replication – Any formula created in an adjacent column to make calculations on table 
data is automatically replicated across all rows. 

• Duplicate Data – Users can highlight or remove duplicate rows with a few simple commands. 

• Table Styles – A large gallery of table styles is available for automatically formatting tables. Styles 
with banded rows auto-adjust the color bands for record additions, deletions, sorting, and 
filtering. Styles interact with Themes to provide greater flexibility in formatting tables. 

• Structured Referencing – Formulas that reference elements of a table can use row and column 
tags rather than cell references in the formula for clarity and ease of use. 

Think of a table as a two-dimensional Excel database with special functionality. The data should be 
properly laid out with columns as fields and rows as records. The first row should contain the names of 
each field. If the first row does not contain field names, Excel will create generic field names automatically. 

Creating a Table 
To create a table in Excel using the default style, place the cursor inside of the data range and press CTRL 
+ T. In the Create Table dialog box, confirm the table range and check My table has headers as shown in 
Figure 17. 

 

Figure 17 - Create Table Dialog Box 
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Click OK to create the table as shown in Figure 18. Instantly, the table is created with the default style. In 
this case, the default style bands adjacent rows with different colors for readability. Drop-down filter 
arrows are visible at the top of each column. The arrows are for setting filters and sorting and are not 
visible on printouts. Any fields that do not have a name at the top of the column will be named Column1, 
Column2, etc. These fields can be renamed by typing over the labels. 

 

Figure 18 - Creating a Table Instantly with CTRL+T 

Alternatively, the table could have been created from the Ribbon. Again, position the cursor inside the 
data range. From the Ribbon, select Format as Table from the Home tab of the Ribbon. Select a style from 
the gallery and then confirm the table range in the Create Table dialog box. Click OK to create the table. 

Using CTRL + T is a faster and easier process to create a table, but it always creates a table in the default 
table style. To change the default table style, click on Format as Table on the Home tab of the Ribbon, 
right-click on a style, and choose Set As Default. 

 
Styles interact with Themes. Themes contain attributes for fonts, line and fill 
effects, and the color palette. By changing the Theme, the colors and formats 
of a Table Style will be affected. To see the impact, select Themes from the Page 
Layout tab. Then, roll your mouse over the various themes and watch the table 
formats change. Themes give users even greater flexibility in formatting their 
tables. 

Using Table Names 
Excel names each table with a generic name and displays it in the Properties group of Table Tools, Design. 
The table name is part of structured referencing, which will be discussed later. Naming tables with a 
representative name, such as Sales or Invoices, will make building formulas with structured referencing 
easier and more intuitive, especially if multiple tables are present in a single workbook. 
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Turning a Table into a Range 
Some accounting professionals will just want to format their lists with a few clicks. They don't need 
filtering, sorting, or any of the other advanced features, and they certainly don't want the filter arrows at 
the top of each column. Here's the trick. Create a table from the data selecting the desired style in the 
process. Then, change the table back into an ordinary range from the Ribbon by selecting Convert to 
Range on the Table Tools, Design tab. Click OK in the confirmation dialog box, and the table will become 
a range again. Note that the table formatting remains! To turn off the filter arrows in a working table, 
position the cursor inside the table and click Filter on the Data tab or click Sort & Filter, Filter on the Home 
tab of the Ribbon. The same process can be used to turn on filtering again whenever it's needed. 

 
When a table is turned into a range, the style formatting becomes cell 
formatting which may cause unexpected results if the range is later turned back 
into a table. If the table formatting is inconsistent, it may be repaired. Click 
inside the table. From the Ribbon, select Home, Format as Table. Right-click on 
the desired style in the gallery and choose Apply and Clear Formatting. 

Working with Tables 
Let's review the sample table. It consists of monthly sales data for thirteen products over the past six 
months. First, use the check boxes in Table Style Options to explore how styles can be adjusted to meet 
specific needs. Figure 19 shows the results of our efforts. 

 

Figure 19 - Using Table Style Options to Adjust Table Formatting 

 
Altering the options in Table Style Options changes the styles presented in the 
Style Gallery. Formatting tables with styles may be more effective if options are 
set before styles are applied. 
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Figure 20 - Adding Totals to a Table 

Each column in the table can be totaled independently of every other column. In other words, one column 
can be summed while another can be averaged or counted. Copy the total formula to the bottom of all 
sales columns by grabbing the auto-fill box in the lower right-hand corner of the cell containing the grand 
total and dragging the fill box across the row to the January sales column. 

Quick-Add Column, Row 
Excel Tables will also help with the mundane work, such as, adding columns and rows, including formulas.  
The trick to this is inserting the column or row within the table range.  If you create a formula in the new 
column or row, the table will automatically copy the formula to the rest of the column or row.  When 
dealing with a substantial amount of data, this can be a huge time saver. 

 

Figure 21 – Quick-Add 

Freeze Column and Row 
Column and row titles will freeze in place, automatically, as long as you are working in the table.  When 
you click off the table, the column and row headings go back to their original state. 
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Figure 22 – Freeze Column and Row within a Table 

Filtering and Sorting 
The sales manager for Nature's Softness would like to have monthly sales totals for one of the product 
groups. Click the drop-down filter button at the top of the Description column. Clear the Select All button 
in the record list at the bottom of the filter dialog. Next, select all of the Cream products. Click OK to apply 
the filter. The table should resemble the one in Figure 23. Note that the total row calculates the total sales 
for only the records displayed. Also, note the icon on the filter button of the Description column indicating 
that a filter is active. 

 

Figure 23 - Table with Simple Filter Applied 

 

Figure 24 - The Custom Sort Dialog Box 
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Structured Referencing 
Scrolling up to set filters and then down to see totals in a large table is not effective practice. Let's put our 
totals at the top of the table, so that as we set filters, the results will be plainly visible. In the process, we 
will investigate another innovation called structured referencing. Position the cursor in cell E4. Type in the 
label Total and format the label with boldface, right justification, and accounting format. Move right to 
cell F4 and type in the following formula: 

=SUBTOTAL(109,Checks[Amount]) 

The formula sums all checks displayed in the Amount column of the Checks table. As the filters are reset, 
the total displayed will change to reflect the sum of just those records displayed. If filters are cleared, then 
the formula will reflect the sum of all checks written. 

 
As a table is filtered, Excel hides from the user the rows that are not of interest. 
The SUBTOTAL function uses function numbers to determine whether the 
summary calculation includes hidden rows. Hidden rows are normally included 
in summary totals when using function numbers 1-11 except when the rows are 
hidden by active filters, in which case the hidden rows are not included in the 
totals. Hence, it is not necessary to use SUBTOTAL function 109 to sum filtered 
tables so that only displayed rows are included in the totals. 

 
Copy cells E4 and F4 to cells E3 and F3. Change the label in cell E3 to read Mean and change the formula 
in cell F3 to read as shown below. 

=SUBTOTAL(101,Checks[Amount]) 

Manipulate the filters, by any means, so that the number of displayed rows varies in length. Note that the 
mean and total formulas displayed at the top of the table change accordingly as shown in Figure 25. 

 

Figure 25 - Creating Totals at the Top of a Table 

Structured references are a means of working with table data, both inside the table and outside the table. 
Formulas built on structured referencing are self-documenting because they specify data elements within 
a table rather than cell references. There are a number of reserved item specifiers. For example, [#Totals] 
refers to the total row, and @ refers to data elements in other columns but on the same row. A total row 
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exists in the sample table shown in Figure 25. To create a formula in the worksheet to refer to the total 
displayed at the bottom of the Amount column as its value and position changes, use this formula. 

=Checks[[#Totals], [Amount]] 

As the formula is entered from the keyboard, Formula AutoComplete will display the tables and fields for 
selection, just as with functions and range names. To learn more about this innovation, search for 
"structured references" in the Excel help system. 

Removing Duplicate Records 
One of the best features of the two latest versions of Excel is their ability to easily identify or remove 
duplicate values in a range or table. 

 
Using the Remove Duplicates command is destructive. The rows in a range or 
table identified as duplicates will be deleted from the data. Make sure that you 
save a copy of the workbook with a different file name before executing the 
command. 

 
Continuing with our example, Rod Hesson would like to a have a sorted list of all payees who received a 
check in 2009 or 2010. To produce the list he needs, simply remove all duplicate records in the Name 
column. 

First, keeping in mind that removing duplicate records is a destructive process, save the workbook with a 
different file name. Then, clear all of the filters and sorts in the sample table. To remove the duplicate 
payees, position the cursor in the table and select Data, Remove Duplicates. Uncheck all columns except 
Name in the Remove Duplicates dialog box as shown in Figure 26. Click OK and then OK again to confirm 
the removal. Sort the Name column in ascending order to complete the task. 

 

Figure 26 - Selecting Columns from Which to Remove Duplicates 

Alternatively, an advanced filter could have been applied to the Name field. Using an advanced filter is 
not destructive, and the filtered list can be copied to another range in the worksheet as part of the filter 
command. Before discussing advanced filters, let's take a few minutes to discuss the process of selecting 
a range in a table. 
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Selecting Table Rows or Columns 
A table is a single unitary object within a worksheet. Think of a table as a worksheet within a worksheet. 
In other words, users can insert, delete, or move rows and columns within a table without disturbing the 
surrounding worksheet. Moreover, users can select rows and columns in a table without selecting entire 
rows and columns in the surrounding worksheet. To select a row, position the cursor just inside the left-
hand margin of the row. The cursor will change to a small dark arrow pointing to the right or inside of the 
table. Click to select the row. Right-click and select Insert, Table Rows Above to insert a row in the table 
but not in the surrounding worksheet. If the cursor is positioned too far to the left, in the worksheet row 
reference, the entire row in the worksheet will be selected. The correct and incorrect cursor positions are 
shown in Figure 27. 

 

Figure 27 - Positioning Cursor Properly to Insert Row in Table 

The data in a table or an entire table can be selected by positioning the cursor just at the upper left-hand 
corner of the table. The cursor will change to a small dark arrow pointing down and to the right inside the 
table. Click once to select the data and twice to select the entire table, including the headings and total 
row. The correct cursor position for selecting an entire table is shown in Figure 28. 

 

Figure 28 - Positioning Cursor to Select Entire Table 

Note the similarity of working with rows and columns in Word tables. If you have ever worked with tables 
in Word, then you will recognize the process immediately. 

Filtering Duplicate Records 
The last example of working with duplicate records involves using conditional formatting to highlight 
duplicate records and then filtering by color to find the duplicates. For example, users may want to identify 
checks issued with duplicate check numbers. 

Using the QuickBooks check data, clear all active sorts and filters. Sort the Date column in ascending date 
order. Select the data in the Num column by any means. Then, select Conditional Formatting, Highlight 

CORREC
 INCORREC
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Cells Rules, Duplicate Values from the Home tab of the Ribbon. In the Duplicate Values dialog box, select 
Duplicates and accept the default color scheme as shown in Figure 29. Click OK to apply the conditional 
formatting. 

 

Figure 29 - Formatting Duplicate Values 

Slicers for Tables 
Think of Slicers as end-user filters. Slicers have been available to filter PivotTables and PivotCharts since 
Excel 2010. Now they are available for filtering Excel Tables, and can even be used to filter Tables 
connected to external data sources. To apply a Slicer to a Table, place the cursor in the data and then 
select Insert, Slicer on the ribbon. In the Insert Slicers dialog box, check the fields that you desire to filter 
in the Table and click OK to create the Slicers, as shown in Figure 30. Arrange, format, and apply styles to 
Slicers on the Slicer Tools, Options contextual tab. 
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Figure 30 – Applying Slicers to a Table 

 

Introduction to PivotTables 
PivotTables are the most powerful feature of Excel, yet few accountants use them in their day-to-day 
activities. For some, PivotTables are too intimidating; for others, PivotTables are unknown. PivotTables 
may be challenging at first, but with a little instruction and guidance, they will become part of your regular 
repertoire for analysis and reporting. reports in the PivotTable task pane, grouping and custom grouping, 
ungrouping, data summaries, creating calculated items and using advanced summarization techniques.  
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What is a PivotTable? 
A PivotTable report is an interactive table that automatically extracts, organizes, and summarizes data. In 
just a few clicks, users can go from raw data to a completed report, as shown in Figure 31. A PivotTable 
report can be used to analyze data — for example, to make comparisons, to detect patterns and 
relationships, or to uncover trends. PivotTables are extremely useful for summarizing and analyzing large 
amounts of data efficiently and effectively. For example, a CFO may need to summarize fifty thousand 
sales transactions to produce quarterly totals by product line within sales region. Alternatively, a public 
practitioner evaluating audit risk may need to summarize all of a client's bill payment checks by vendor 
and by quarter. In both examples, users would like to be able to drill on the summarized totals in the 
report to see the detailed transactions that underlie the totals. PivotTables can provide all of this 
functionality and more, quickly and with computational accuracy. 

 

Figure 31 – From Raw Data to PivotTable Report in a Few Clicks 

Excel uses specific terms to identify the elements of a PivotTable report. The main elements, shown in 
Figure 32, are row fields, column fields, report filters, values fields, items, and the data area. 
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Figure 32 - Parts of a PivotTable 

 
Report Filters 

 
Items 

 
Values Fields 

 
Row Fields 

 
Column Fields 

 
Data Area 

 

Row Fields are fields from the source data that are assigned to a row layout in a PivotTable. Region and 
Product are row fields in Figure 32. 

Column Fields are fields from the source data that are assigned to a column layout. Quarter is a column 
field in Figure 32. 

Report Filters are fields from the source data that act as filters in a PivotTable report. Years is a report 
field in Figure 32. The Years field could be used to display data from a single year, such as 2014, or multiple 
years, such as 2013 and 2014, etc. 

1 2 3 4 

5 6 
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Items are the elements within a row, column, or report filter. In this example, the Region field contains 
these items: East and West. The Product field contains these items: Pipe, 1/2-inch, Galv; and Pipe, 1/2-
inch, Sch 40, etc. 

Values Fields are fields from the source data that contain values to be summarized. Sales is a values field 
in Figure 1. For numeric data, users can choose how to summarize the data (sum, average, count, etc.). 
For text data, users can count the number of times a specific text entry, such as Yes or No, appears in a 
field. 

The Data Area is the range of cells in a PivotTable report that contains summarized data. For example, the 
value in cell C5 summarizes sales for the product Pipe, 1/2-inch, Galv, for the East region in the first quarter 
of 2012. In other words, cell C5 provides a summary of the sales figures for every row in the source data 
that contains the items Pipe, 1/2-inch, Galv, East, Qtr1, and 2012. 

Simple PivotTables 
A large portion of the productivity and information analysis benefits of using PivotTables is gained with 
the simplest of PivotTables. In other words, you need not be a PivotTable expert or know how to apply 
the advanced features of PivotTables in order to take advantage of their power and functionality. The Law 
of Diminishing Returns applies! As our PivotTables become more complex, the amount of learning 
required to take advantage of their more complex functionality increases. For most analyses, a simple 
PivotTable that auto-summarizes or auto-tabulates our data will be very effective and will provide all of 
the power that we need. 

The table of data in Figure 33 contains sales data extracted from a general ledger. It will serve as the data 
source for our initial PivotTable examples. Each record represents the total sales by month for a specific 
product. There are three columns of data – Month, Product, and Sales. The sales figures could be in units, 
thousands of units, dollars, or thousands of dollars, etc. In this case, we will assume that sales are reported 
in dollars. 

In our sample data set, there are nearly one hundred rows of data, although many data sets may have 
thousands of rows. The latest version of Excel supports over one million rows in the worksheet grid. 
PowerPivot in Excel 2013 supports data sets up to ninety-nine billion records. As you can see, PivotTables 
can be used to summarize very large data sets. While there are no practical limits on the amount of data 
that can be used in a PivotTable, the more data there is to summarize or analyze, the greater the power 
of PivotTables. 
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Figure 33 - Data for Simple PivotTable Examples 

In our first example, we would like to tabulate the sales figures by Product and by Month of sale. Our 
completed PivotTable will have rows for the Product and Months for the columns. 

To create a simple PivotTable from our data, do the following. 

1. Place the cursor in the data and click PivotTable on the Insert tab, as shown in Figure 34, to 
open the Create PivotTable dialog box. 

 

Figure 34 - Select PivotTable from the Insert Tab 

2. In the Create PivotTable dialog box, shown in Figure 35, the data range should already be 
defined. If not, click the Collapse Dialog button and highlight the data range. Make sure that 
the entire data range is selected, including the field names at the top of the data columns. 
Select New Worksheet and then click OK. Note that a Table can serve as a dynamic data range 
for a PivotTable in Excel 2007/2010/2013. 

Copyright © 2018 K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises training event is prohibited. 
34



 

 

 

Figure 35 - Highlight the Data Range and Select New Worksheet 

3. A new worksheet, like the one shown in Figure 36, will be inserted in the workbook. On the left 
side of the worksheet is a placeholder for the PivotTable report to be created. On the right side 
is the PivotTable Task Pane. The layout of the task pane can be customized to a user's needs 
by clicking the drop-down button in the top right corner of the task pane just below the title 
bar. 

4. The task pane contains the PivotTable Field List at the top and four drop areas into which fields 
can be dragged from the list to create the PivotTable. The drop areas correspond to the four 
areas of a PivotTable report: Report Filters, Column Labels (column fields), Row Labels (row 
fields), and Values (data area). 

 

 

 

 

 
Experienced PivotTable users will recognize Report Filters as Page Fields in 
earlier versions of Excel. Report Filters are just a new, more descriptive, name 
for existing functionality. Report Filters serve the same function and work 
exactly as Page Fields. 
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Figure 36 - Creating a PivotTable by Dragging Fields to the Drop Areas 

5. Now, drag each of the fields, in turn, from the field list at the top of the PivotTable Task Pane 
to the drop areas at the bottom, as shown in Figure 36. 

6. Click on the Month field, hold down your left mouse button and drag and point to the Column 
Labels drop area, and then release your left mouse button. 

7. Click on the Product field, hold down your left mouse button and drag and point to the Row 
Labels drop area, and again release your left mouse button. 

8. Click on the Sales field, hold down your left mouse button and drag and point to the Values 
drop area, and then release your left mouse button. 
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Turn off the field headers in the report for presentation. Click Field Headers on the PivotTable Tools, 
Analyze tab, to turn off the headers, as shown in Figure 37. Next, rename the Sum of Sales label by typing 
the desired label into the cell. Simply click in the cell containing the label Sum of Sales and enter Monthly 
Sales by Product. 

 

Figure 37 - Hiding the Field Headers and Entering a Descriptive Label for Presentation 

Cells in a PivotTable can be formatted for printing and display just as with any other cell or range of cells. 
In our example PivotTable, the sales values in the report need to be formatted in the Accounting format 
with zero decimals and without dollar signs. The first and total rows of the sales values need to be 
formatted with dollar signs for presentation.  

Excel also has a large number of built-in visual styles with which to format PivotTables automatically. 
These styles, available in the PivotTables Styles gallery on the PivotTable Tools, Design contextual tab, 
contain a wide variety of colors and formatting for the table, table headers, and total and subtotal rows. 
Figure 38 shows our PivotTable report with the values formatted as dollars and one of the built-in styles 
applied. 
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Figure 38 - PivotTable with Accounting Format and Style Applied 

Grouping and Ungrouping Data 
Now, let's examine some of the power of PivotTables. To calculate and display quarterly sales totals for 
each of the products, simply group the months into quarters. Position the cursor in a cell containing one 
of the monthly column headings, such as Jan-2015. Right-click, and choose Group to open the Grouping 
dialog box. In the By box, click Quarters, so that Months and Quarters are highlighted, as shown in Figure 
39. Click OK to complete the task.  
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Figure 39 - Grouping Months into Quarters 

Turn off the field headers for presentation. On the PivotTable Tools, Analyze contextual tab, click on Field 
Headers. Next, position the cursor in a cell containing one of the quarterly column headings, such as Qtr1. 
Right-click on the cell and from the context-sensitive menu, select Subtotal "Quarters" to add a quarterly 
subtotal for each quarter. The initial results are shown in Figure 40. Some of the columns have been 
removed for presentation. 

 

Figure 40 - Results of Grouping Months into Quarters 
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Again, position the cursor in a cell containing one of the quarterly column headings, such as Qtr1. Right-
click on the cell and from the context-sensitive menu, select Expand/Collapse, Collapse Entire Field. 
Months are collapsed into Quarters, and all of the totals now reflect quarterly totals as shown in Figure 
41. Detail can be shown or hidden for a single group or an entire field from the context-sensitive menu. 

 

Figure 41 - Monthly Data Grouped into Quarters 

To see the detail observations that underlie any of the cells, just double-click on the cell of interest. Excel 
will insert a new sheet containing the detail observations that created the cell contents. For example, if a 
user double-clicked on 34,260 (Qtr4 sales for 1-inch Sch 40 Pipe) in our sample PivotTable, Excel would 
display the underlying detail as shown in Figure 42. Note that the data is presented in Table form and 
format, which makes it easy to filter and analyze. In this case, a Total Row was added to the table, thereby 
providing a supporting schedule for the summarized value. 

 

Figure 42 - Drilling to Detail from a PivotTable 

Custom Groups 
In the example PivotTable, data items were summarized using built-in groups, such as when months were 
grouped into quarters. However, Excel allows data to be grouped with user-defined groups. To accomplish 
this task, first highlight the items to be grouped together. Then, right-click and select Group from the 
context-sensitive menu. 
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In the example PivotTable, we would like to group the products into one of three product lines – Iron, 
Plastic, and Copper. The galvanized pipe products make up the Iron group, the schedule 40 products make 
up the Plastic group, and the tubing products make up the Copper group. Click on product Pipe, Galv, 1-
inch, hold down the CTRL key and then select Pipe, Galv, 2-inch and Pipe, Galv, 3-inch. Next, right-click 
and choose Group from the context sensitive menu. This combines the first three products into a single 
group. Rename the Group1 label to Iron to complete the first group, as shown in Figure 43. 

 

Figure 43 - Grouping Products into Product Groups 

Repeat the steps for each of the two remaining groups, Plastic and Copper. To complete the PivotTable, 
add subtotals for each of the product groups. Position the cursor in a cell containing one of the group row 
headings, such as Iron. Right-click on the cell and from the context-sensitive menu, select Subtotal 
"Product2" to add a subtotal for each product group. The completed report should resemble the one 
shown in Figure 44. 

Highlight the galvanized 
    

Rename the group by typing 
Iron in the cell that contains 
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Figure 44 - PivotTable with Product Groups and Subtotals 

 
Note that the default field name, Product2, given by Excel to the product group can be renamed 
in Field Settings. Right-click on any one of the group labels and select Field Settings from the 
context-sensitive menu. In the Field Settings dialog box, type in the desired field name, such as 
Product Line, in the Custom Name box and click OK. 

Note that the default Compact layout puts group subtotals at the top of the group on the same 
line with the group name. If subtotals are desired at the bottom of each group, select Subtotals, 
Show All Subtotals at Bottom of Group on the PivotTable Tools, Design contextual tab. 
Alternatively, right-click on any one of the group labels and select Field Settings. In the Field 
Settings dialog box, on the Layout & Print tab, uncheck Display subtotals at the top of each 
group, and click OK. 
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Pivoting Columns and Rows 
The summarized table can be rearranged, or pivoted, to show the data from any perspective. Along with 
the ability to group or ungroup data, being able to immediately rearrange the table is among the most 
powerful features of PivotTables. For example, if users wanted to display Products as the columns and 
Quarterly Totals as the rows, they would simply rearrange the rows and columns by dragging and dropping 
the fields in the drop areas. Continuing with our example PivotTable, follow along with your instructor as 
we demonstrate the ease of rearranging a PivotTable report.  

1. Position the cursor in the PivotTable report to display the PivotTable Task Pane. In the field list at 
the top of the task pane, uncheck Month and Product Line to remove them from the report. Click-
and-drag Quarters to the Row Labels drop area below Product. This has the effect of reporting 
Quarters within Products, as shown in Figure 45. 

 

Figure 45 - Dragging Fields in the PivotTable Task Pane to Rearrange a Report 

2. Now, click-and-drag Quarters to the Column Labels drop area. This rearranges the report so that 
Products are the columns and Quarters are the rows. 

To review, we are simply dragging the field buttons to different drop areas in the PivotTable Task Pane in 
order to rearrange the report. We can view a report with Month and/or Quarters across the columns and 
Products as the rows, or Products as the columns and Months and/or Quarters as the rows, Months within 
Products, or Products within Months, etc. The number of ways that we can view a PivotTable is limited 
only by the number of fields that we have to display and our imagination. 
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At first glance, the power of PivotTables to reduce the time and tedium of preparing routine reports is 
significant. However, the real power of PivotTables is not clerical; it is the added ability they provide to 
view data from different perspectives. By viewing data from different perspectives, PivotTables increase 
the probability of uncovering relationships in the data that were previously unknown and of exploiting 
these relationships on behalf of our company or our clients. Now, that's analytical power! 

Using Field Settings 
In our PivotTable examples above, the individual data elements were summed to produce the report. By 
changing field settings, we can display the average sales in each cell, or the minimum or maximum sales, 
or the variance or standard deviation of the sales distribution, etc. Field Settings are accessible in any of 
several ways: 1) Right-click on a field label and select Field Settings or Value Field Settings from the 
context-sensitive menu, 2) Position the cursor in a cell containing a field label or value and select Field 
Settings from the PivotTable Tools, Analyze contextual tab, or 3) Click the drop-down arrow of any field 
button in a drop area in the PivotTable Task Pane and select Field Settings or Value Field Settings from 
the menu. 

To change the summary function for any value field, open the Value Field Settings dialog box using any of 
the described methods. In the Summarize value field by box, select the function to use in summarizing 
the field's values. To summarize the selected field by calculating averages, select Average, as shown in 
Figure 46.  

 

Figure 46 - Changing the Summary Function for a Value Field 

In the next example, a PivotTable report that displays four columns, one each for the total annual sales 
by product, the average sales by product, and the minimum and maximum sales by product will be 
created. Since the statistics are calculated on sales data, the sales field must be dragged to the Values 
drop area four times, once for each summary column to be displayed. The Field Settings (field name and 
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summary function) for each field are then modified, in turn, to reflect the appropriate calculation. Figure 
47 illustrates this process and the finished report. Follow along with your instructor as we explore multi-
column reports and field settings. 

 

Figure 47 - Creating a Multi-Column PivotTable to Display Sales Statistics 

Let's add another column to our report. In this final example, the CFO would like to have a column that 
displays the sales of each product as a percentage of total sales. Since the column will summarize sales 
data, the Sales field must be dragged to the Values drop area once again. Right-click on its column heading 
and select Value Field Settings. Click on the Show values as tab and in the Show values as drop-down list, 
select % of column and click OK. Type in Percent as the new column heading, drag the new Percent column 
just to the left and adjacent to the Totals column, and then adjust the column widths to complete the 
PivotTable report, as shown in Figure 48. 
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Figure 48 - Using Percentage of Column to Display Sales as a Percentage of Total Sales 

Sorting and Filtering Fields 
The latest versions of Excel provide enhanced context-sensitive sorting and filtering of PivotTable fields. 
All of the sorting and filtering capabilities are easily accessible in the Field List at the top of the PivotTable 
Task Pane. Click the drop-down arrow of any field button and select the appropriate sort or filter options, 
as shown in Figure 49. 
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Figure 49 - Sorting or Filtering PivotTable Fields 

Updating the Underlying Data 
Whenever data is changed, updated, or added to the underlying data set, a user must refresh the 
PivotTable to see the changes reflected in the report. Position the cursor anywhere in the PivotTable 
report, and then right-click and choose Refresh from the context-sensitive menu. Alternatively, click the 
Refresh button on the PivotTable Tools, Analyze contextual tab. Note that it is best practice to refresh a 
PivotTable after re-arranging a complex report. 

If data is added or removed from the data range and the size of the range changes, then users may have 
to modify the data range. If the data range is an Excel table, no action is necessary. A table is a dynamic 
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range that re-adjusts its dimensions automatically as data is added or removed. Similarly, if the data range 
is a named dynamic range, no action is necessary. However, if the data range is an ordinary range specified 
using cell references, the data range must be adjusted. To adjust the data range, position the cursor in 
the PivotTable report. On the PivotTable Tools, Analyze contextual tab, click Change Data Source. In the 
Change PivotTable Data Source dialog box, re-specify the data range and click OK. The existing PivotTable 
will be updated to reflect the new data. 

Recommended PivotTables in Excel 2013 
Excel 2013 attempts to ease the burden of learning how to use PivotTables with Recommended 
PivotTables. Excel produces a gallery or pre-configured PivotTables, from which a user need only make a 
selection.  

 

Figure 50 - Creating a PivotTable with Recommended PivotTables 
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While the PivotTables produced by this functionality are the simplest of reports, they can serve as the 
foundation for more sophisticated analysis. In this context, Recommended PivotTables can save many 
steps in the report creation process, thereby saving time and delivering greater staff productivity. 

Producing a recommended PivotTable takes just a few clicks. Highlight the data, including the field names, 
or use a Table for the data, and then click Recommended PivotTables on the Insert tab. From the gallery 
of PivotTables, select the one that best summarizes the data and click OK, as shown in Figure 50. The 
PivotTable may then be customized and formatted to meet a user's needs. Note that recommended 
PivotTables can also be created from the Tables tab of the Quick Analysis lens. 

PivotTables on External Data Sources 
Most users build PivotTables on data stored in the workbook where the PivotTable is being built. Under 
these circumstances, the creation and update of a report will require the extraction of data from the 
application where the data is stored and maintained, which is usually the general ledger or other business 
application. Alternatively, we could use the Open DataBase Connectivity (ODBC) capabilities of Excel to 
extract the data from the general ledger. Once we connect a PivotTable to our general ledger using ODBC, 
Excel becomes an extraordinarily effective ad hoc reporting engine. 

What is ODBC? 
ODBC is a standard database access method developed by the SQL Access group in 1992. With ODBC, it is 
possible to access data stored in any ODBC-compliant database from within any ODBC-compliant 
application. ODBC manages this by inserting a middle layer, called an ODBC driver, between the 
application and the database management system (DBMS) that translates the application’s data queries 
into commands that the DBMS understands. ODBC can be used to provide two-way integration between 
Excel and the general ledger, although generally ODBC is used only to extract data. 

ODBC is an open, vendor-neutral interface for database connectivity that provides access to a variety of 
PC, RISC, and mainframe database systems. The ODBC programming interface permits a developer to 
build an application without targeting a specific DBMS. Users can add drivers that link their applications 
to a database management system and then can access their data using conventional SQL query 
commands. Most accounting software applications support ODBC. If your accounting software supports 
ODBC, then Excel can access historical data directly in the general ledger without re-keying any data or 
going through the typical import-export process used by most management accountants. 

All of the Microsoft Office applications are ODBC compliant. Office comes with ODBC drivers for Access, 
Excel, dBase, and text files. Windows 7 and Windows 8 broaden the ODBC capabilities of Windows 
applications by adding drivers for SQL Server, Visual FoxPro, Oracle, and Paradox. The Windows ODBC 
drivers are part of Microsoft Data Access Components (MDAC), the latest version of which can be 
downloaded from the Microsoft web site. 
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Extracting Data from an External Database 
Using ODBC, Excel can easily connect to an external database and extract any necessary data. Figure 51 
depicts a graphical representation of the data access process. Direct extraction may not solve all of our 
problems. In earlier versions of Excel, it was not uncommon for a data extraction to exceed the row or 
column capacity of Excel. Users were forced to use an intermediary database, such as Access, to store the 
data temporarily. However, if users extract data directly into a PivotTable and thereby summarize the 
data in a limited number of rows or columns, the row and column limits of Excel are not exceeded even if 
the data itself exceeds the limitations. 

 

 

Figure 51 - Accessing Data in Excel Using ODBC 

The process of creating a PivotTable from an external database is the same as for any other PivotTable 
except that users must specify a source database and the database fields that contain the data of interest. 
If the data source has already been defined in Excel, the PivotTable creation process is simplified. On the 
Insert tab, select PivotTable, PivotTable. In the Create PivotTable dialog box, select Use an external data 
source and click Choose Connection. Select an existing data source in the Existing Connection dialog box 
and click Open. Then, continue the process to create the desired PivotTable. 

If the data source has not been defined, begin the PivotTable creation process on the Data tab. Click From 
Other Sources, From Microsoft Query to open the Choose Data Source dialog box. Select the appropriate 
ODBC data source, and click OK, as shown in Figure 52. In the resulting dialog box, select the desired tables 
and/or fields from the table list. 

In this example, we will be using MAS 90 data from the ABC sample company file. After selecting the data 
source in the dialog box shown in Figure 52, choose a company file and authenticate to MAS 90, if 
necessary, by entering a username and password. The ODBC driver for MAS 90 requires authentication 
for each use if ODBC security is enabled. ODBC security can be set from within MAS 90 to restrict access 
to the general ledger data on a user by user basis. When users authenticate themselves to a company file, 
the users will only have access to the data for which they have been granted specific rights and 
permissions. Only a MAS 90 administrator can alter the data access rights and permissions of an individual 
user. 
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Figure 52 - Selecting the External Data Source 

Next, choose the desired fields from a single table, in this case the customer master file, AR_Customers. 
Expand the field list by clicking on the plus (+) sign to the left of the table name in the left-hand pane. 
Then, choose the fields that are to be displayed in the report and click on the (>) button to move them to 
the right hand pane, as shown below in Figure 53. Select the following fields: CustomerNo, State, 
SalespersonNo, CurrentBalance, AgingCategory1, AgingCategory2, AgingCategory3, and Aging 
Category4. 

 

Figure 53 - Select the Fields for the Report 

After the required fields are selected, click Next several times. In the Query Wizard - Finish pane, select 
Return Data to Microsoft Office Excel and click Finish. In the Import Data dialog box, select PivotTable 
Report, specify the location for the report, and then click OK. Next, drag and drop the fields to the 
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appropriate report drop areas in the PivotTable Task Pane, rename and format the column labels, choose 
a number format for the data, and complete the PivotTable just as with any other. The major difference 
is that this PivotTable is dynamically linked to the underlying data in the General Ledger. If users need the 
same report next week or next month, all they need to do is retrieve the workbook, refresh the PivotTable, 
and print the updated report. The process to update and print the report takes seconds to complete. 
Figure 54 illustrates the creation of the initial PivotTable. 

 

Figure 54 - Creating a PivotTable Connected to an External Data Source 
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The PivotCache – A Temporary Data Store 
Would users be able to send this report by e-mail to their managing partner in another office? After all, 
the PivotTable gets its data from MAS 90, and the managing partner doesn’t have access to the data. The 
simple answer is "Yes." When Excel retrieves data from a data source, it puts the data into a work area 
called the PivotCache. The PivotTable is actually built on the data residing in the cache, not directly on the 
data in the external database. The reason for this is to speed up the data manipulation process – the 
dragging and dropping, the grouping, the renaming, and the rearranging – that goes on when we use 
PivotTables. Figure 55 illustrates the PivotTable data model. 

The PivotCache becomes part of the workbook and is always in the background, unseen and inaccessible 
except through the PivotTable. Whenever a user sends a PivotTable by e-mail or direct file transfer, the 
PivotCache accompanies the PivotTable as part of the workbook, so that the recipient can view the report 
and drill down to the underlying details as if she were connected to the MAS 90 database. 

 

Figure 55 - PivotTable Data Model 

Timeline Filters 
Timeline filters in Excel 2013 are similar to slicers, but are used to filter date fields in PivotTables. If you 
are using PivotTables to analyze transactional data, every record in your data set will have a date 
associated with it. Usually, dates are grouped into months, quarters, or years for reporting and analysis. 
Date grouping adds another layer of complexity that makes it more difficult for less knowledgeable users 
to create and manipulate PivotTables. That's where Timelines come in to play. Simply click in a PivotTable 
and select Timeline from the Insert tab to produce a Timeline filter as displayed in Figure 56. To change 
how the data is grouped (months, quarters, or years), click the drop-down in the upper right hand corner 

Database 

PivotCache 
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of the Timeline control. To filter the PivotTable, click on a period button, such as Q1, Q2, etc., or drag your 
mouse across the Timeline to select multiple periods. The selected period is displayed in the upper left 
hand corner of the control. 

 

Figure 56 – Using a Timeline to Filter Dates in a PivotTable 

Flash Fill 
Flash Fill is a new data manipulation feature that allows users to split, combine, or rearrange data quickly 
and easily without using commands or complicated formulas. Whether it's rearranging customer contact 
names, inserting parentheses and hyphens in telephone numbers, or separating account numbers and 
account names in a QuickBooks trial balance, Flash Fill can get the job done, as shown in Figure 57. 

 

Figure 57 – Use Flash Fill to Manipulate Data 

There are multiple ways to apply Flash Fill. In default, Excel displays Flash Fill suggestions as you work. As 
shown in Figure 58, a user has modified the first record and has moved to the second record. As the user 
begins modifying the second record, Excel automatically displays a suggested flash fill for the column. At 
that point, the user can press ENTER to accept the suggested flash fill or press ESC to cancel the suggested 
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fill. Alternatively, select Data, Flash Fill from the ribbon or press CTRL + E to execute Flash Fill from the 
keyboard. 

To reformat a list of telephone numbers, type one number as it is to appear with parentheses and a 
hyphen, press ENTER, and then press CTRL + E. If Excel is unsure of what is to be done for any record, it 
will skip the record. Move the cursor to a skipped record and "correct" it, and then press CTRL + E to fill 
similar records. Continue this process until the entire column has been updated. 

 

Figure 58 – Excel Automatically Displays a Suggested Flash Fill 

Here's a few tips for using Flash Fill effectively: 

• Flash Fill does not create formulas related to the original records, so the original data column can 
be deleted without impact on the fill column. 

• The fill column need not be adjacent to the column that contains the data to be manipulated, but 
make sure that there are no blank columns between the original data and the intended fill column.  

• Flash Fill cannot be used to transform numbers. For example, Flash Fill cannot be used to divide a 
column of numbers by five. Use formulas instead. 

• A column can be filled from any record in the column. If the first record contains ambiguous data, 
use another record to demonstrate how the data is to be manipulated and then press CTRL + E to 
force the execution of Flash Fill. 

• Flash Fill is a pattern recognition engine, not a logic engine. Flash Fill cannot be used to convert 
state names to state abbreviations because it does not recognize that UT and LA are the 
abbreviations for Utah and Louisiana, respectively. Use Custom Lists or a VLOOKUP table instead. 

The Excel Data Model 
All versions of Excel 2013 include the Excel Data Model, a core in-memory OLAP data engine. The Data 
Model provides users with additional PivotTable functionality, but it also removes some functionality with 
which many users are familiar and are accustomed to using. In order to use the newest and most powerful 
functionality associated with the Data Model, users must give up some tried and true functionality. 

The Excel data model provides PivotTables with new and powerful functionality. 

Press ENTER to accept the 
suggested flash fill or press 
ESC to cancel flash fill. 
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• PivotTables can be built from multiple related tables. The ability to establish relationships 
between tables eliminates the need to build VLOOKUP formulas to cross-reference information 
stored in different tables. Relationships between tables can be defined before or during the 
PivotTable building process. 

• PivotCharts without an accompanying PivotTable (Standalone Pivot Charts) are available in Excel 
2013 when the data is stored in the Excel Data Model. 

• Quick Explore, a revolutionary way to drill to detail, allows users to drill up, down, and around a 
PivotTable to examine and explore a report's underlying data more easily. In order to use Quick 
Explore, a PivotTable must be built on the Excel Data Model. 

• Since the Excel Data Model is an OLAP data engine, this allows users to convert PivotTables to 
formulas using the OLAP Tools available in Excel 2013. This converts a PivotTable from a single 
unitary object into individual cells connected to the underlying data, which allows users to insert 
rows or columns, to create subtotals as required, or to move connected cells to produce entirely 
different reports. All this can be done without breaking the links to the underlying data or 
impairing the ability to refresh a report after the data has been updated. 

Notwithstanding the powerful advantages of building PivotTables on the Excel Data Model, there are 
several significant disadvantages. 

• Grouping of items is not available in a PivotTable built on the Data Model. Neither built-in date 
grouping nor custom item grouping is available. Calculated fields can be created in the source 
data to work around this limitation. 

• Calculated fields and items are not supported. Calculated fields can be created in the source data 
as a workaround. PowerPivot users can create calculated fields in PivotTables built on the Excel 
Data Model from within PowerPivot. 

• In default, drilling to detail only displays the first 1000 records that underlie a summarized cell. 
With the introduction of Office 2013 SP1, Data Model drill-through can be configured to return as 
many records as desired, up to the maximum number of rows available in Excel. 

• Excel 2013 workbooks that use the Data Model are not backward compatible to earlier versions 
of Excel. For workbooks that must be shared with users of earlier versions of Excel, ordinary 
PivotTables – those not based on the Excel Data Model – may be used. 

From the outset, users must be keenly aware that the Excel Data Model need not be used when 
constructing PivotTables in Excel 2013. When the additional features of the Data Model are warranted, 
users can employ the Data Model. When the features are not needed, or when data sets are small, users 
still have all of the features of ordinary PivotTables – the ability to create calculated fields and calculated 
items, group data items, drill through to display all supporting data, and backward compatibility. Those 
using Excel 2013 Professional Plus or the standalone version of Excel 2013 (acquired not as part of a 
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Microsoft Office license) have yet a third type of PivotTable, those built with PowerPivot. PowerPivot uses 
the Excel Data Model, but it can connect to multiple external data sources, handle billions of records, and 
provide users with additional functionality not available to those using just the Excel Data Model. 

4-4-5 Reporting with Related Tables 
Earlier in this session, we used VLOOKUP to retrieve reporting period information from a table into the 
transaction summary to build a PivotTable report. With the Excel Data Model, we can simply relate the 
Sales transaction summary table to the Dates table, thereby avoiding the complexity of building VLOOKUP 
formulas to perform this task. The only requirement is that the Dates table contain a record for each date, 
rather than just the beginning date for each period, as required to use VLOOKUP. Similarly, we could use 
related tables instead of VLOOKUP in transforming coded data into an understandable format. 

Begin the PivotTable creation process by selecting Insert, PivotTable to open the Create PivotTable dialog 
box. Enter the name of the first table and make sure to check Add this data to the Data Model as shown 
in Figure 59. Click OK to display the PivotTable placeholder and Field List. 

 

Figure 59 – Creating a PivotTable Using the Excel Data Model 

When a table is added to the Data Model, the PivotTable Field List can display all fields from all tables in 
a workbook. If the tables are not related, relationships can be created on a common field directly from 
the Field List as shown in Figure 59. With the Excel Data Model, end users can create PivotTables from 
multiple related tables, even if the tables themselves are from multiple external data sources. 
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Relationships 
In the previous example, establishing relationships between tables was accomplished through a link in the 
PivotTable Field List. A more sophisticated approach to establishing and maintaining data relationships 
between tables is available through the ribbon. Select Data, Relationships to access this functionality as 
shown in Figure 60. 

 

Figure 60 – Creating and Maintaining Data Relationships 
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10 Rules of Pivot Tables 

Copyright © 2015 K2 Enterprises 

1. You must have data that is clean and can be pivoted with no blanks or weird 
characters in the data. 

2. Perform a “Save As” as often as you can.  Save versions of your work because 
sooner or later you will have a mess to recover from. 

3. There are five ways to deal with a variable data source: 

a. Go back into the table settings and change the data range 

b. Use a Defined Name on the source range 

c. Use a Dynamic Defined Name on the source Range 

d. Highlight all in the column 

e. Use an Excel Table as the source 

4. When highlighting the data range, you must include the column headings in 
the first row which will become the data titles for the pivot table. 

5. If you happen to include any empty cells or text in your data range the pivot 
table command will automatically default back to count as the field setting 
instead of sum.  To fix change the field setting back to sum. 

6. To re-activate the field list box and pivot table toolbar you need to click back 
in the pivot table range or right-click and select show field list box then issue a 
View, Pivot Table Toolbar command. 

7. If you want 4 different elements of a data item such as sales in your table you 
must drag and drop four instances of that data item into the data range of the 
pivot table. 

8. To group on dates you must have real dates and not text dates.  Convert the 
text dates to real dates using Data, Text to Columns command and then group. 

9. Never name a calculated item or field with the same title you want to use in 
the actual pivot table summary.  You cannot duplicate names of items, fields, 
or calculations. 

10. By default, any grouped item will not have a subtotal on that item.  You will 
need to add those manually if desired.  Fix this in the field 
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The Excel Data Model 
The Data Model in Excel 2013/2016 is the key to better data analysis. This in-memory, multidimensional, 
relational data engine allows users to combine data from multiple sources and handle data sets that 
contain billions of records without performance degradation. In fact, the Data Model can handle up to 99 
billion records, although no field can contain more than 1.99 billion unique records. Power Pivot functions 
as the user interface to the Data Model as shown in Figure 61. Many users may not have access to Power 
Pivot, but users do not have to use Power Pivot to take advantage of the Data Model.3 Note that each 
Excel workbook contains only one data model, but that single model can serve as the data source for 
multiple data analysis objects in the workbook. As with most innovative technologies, there are both 
advantages and disadvantages of using the Data Model. 

 

Figure 61 – The Data Model Serves as the Data Source for the Power BI Tools in the Excel Environment 

Advantages of the Data Model 
The key advantages of using the Data Model as a data source for PivotTables are identified in the following 
list. 

• The Data Model allows users to build PivotTables from multiple related Tables and from a wide 
variety of common external data sources, while maintaining links to the data so that PivotTable 
reports may be refreshed over time. 

• PivotTables built on the Data Model can be converted to cube formulas with a single click on the 
ribbon. Converting a PivotTable to formulas allows users to insert rows or columns across the 
report to create needed subtotals or other ancillary calculations without impairing the ability to 
refresh the report as the data is updated. 

                                                           
3 Power Pivot is available in Office 2013 and 2016 Professional Plus, Office 365 ProPlus, E3, and E5 subscriptions, and 
the standalone versions of Excel 2013 and 2016. 
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• Cube functions can be used to prepare formal reports directly from the Data Model without 
creating a PivotTable to summarize the data because the Data Model contains an intelligent OLAP 
cube populated from the data tables stored in the model. Think of the cube as a multidimensional 
PivotTable that contains pre-calculated measures at each intersection of the cube. 

• PivotTables built on the Data Model support drill down and around with Quick Explore, a new 
feature available in Excel 2013/2016. Quick Explore provides functionality far beyond mere drill-
to-detail of summarized values that appear in ordinary PivotTables. Quick Explore allows less-
sophisticated users to rearrange a PivotTable in an automated process so that they may view the 
data from other perspectives without having the requisite knowledge or skill to rearrange the 
PivotTable manually. 

Disadvantages of the Data Model 
While there are significant advantages to using the Data Model, there are also disadvantages. The key 
disadvantages of using the Data Model as a data source for PivotTables are identified in the following list. 

• Calculated fields and items are not supported. In Excel 2013, calculated fields (measures) can be 
created with DAX functions using Power Pivot. As a workaround, calculated columns can be 
created in the source data. Dragging a calculated column to the Values area in the PivotTable 
Field List will create an implicit measure automatically. In Excel 2016, users can create calculated 
measures with DAX functions using Power Pivot or directly from the PivotTable Field List as a 
workaround. Right-click on a table name in the Field List and select Add Measure from the 
context-sensitive menu. 

• Grouping of items is not available in a PivotTable built on the Data Model. Neither date grouping 
nor custom item grouping is available in Excel 2013, but date grouping returns in Excel 2016. 
Calculated columns to produce the required groupings can be created in the source data to work 
around this limitation.  

• In default, drilling to detail only displays the first 1000 records that underlie a summarized cell. 
Drill-through can be set to a larger record count in Connection Properties. 

• Excel 2013/2016 workbooks that use the Data Model are not backwardly compatible with earlier 
versions of Excel. 

Using the Data Model 
To use the power of the Data Model on data that exists in an Excel workbook, the data to be analyzed 
must be stored in tables, not ordinary data ranges. Keep in mind that tables can be connected to external 
data sources, such as the accounting system, to automate the process of updating the data. Once the data 
sets are in tables, start the PivotTable creation process by selecting Insert, PivotTable to open the Create 
PivotTable dialog box. Enter the name of the first table and make sure to check Add this data to the Data 
Model as shown in Figure 59. Click OK to display the PivotTable placeholder and Field List. 
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Figure 62 – Relating Tables in a PivotTable Based on the Excel Data Model 

When tables are added to the Data Model, the PivotTable Field List displays all fields from all tables in a 
workbook. If the tables are not related, relationships can be created on a common field directly from the 
Field List as shown in Figure 59. In Excel 2016, relationships between tables can be detected automatically. 
With the Data Model, end-users can create PivotTables from multiple related tables, even if the tables 
themselves are connected to external data sources. This makes it easy for users to combine data from 

In Office 2016, Excel can autodetect 
relationships among tables in the Excel 
Data Model. 
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multiple files or systems to create needed reports or analyses. While there are powerful advantages to 
building PivotTables on the Data Model, there are significant disadvantages as outlined previously, 
especially for experienced PivotTable users. 

Relating Multiple Tables 
In the previous example, establishing relationships between tables was accomplished through a link in the 
PivotTable Field List. In this example, four tables – Transactions, Service, Industry, and Dates – will be 
related to transform the data before beginning the process of building a PivotTable report.  

 

Figure 63 – Creating and Maintaining Data Relationships 

Creating and maintaining data relationships between tables is available through the ribbon. Select Data, 
Relationships to access this functionality as shown in Figure 60. Excel 2016 introduces auto-relationships 
to relate tables, thereby easing the burden of creating numerous relationships across many tables in a 
Data Model. 

Building Data Models to Feed into Power Pivot 
Power Pivot, the interface to the Excel Data Model, provides additional functionality for building reports 
and analyses – PivotTables, Pivot Charts, Power View dashboards, and interactive 3D Maps – using the 
Excel business intelligence add-ins. More importantly, Power Pivot allows users to create Data Models 
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from multiple external data sources. The extracted data can be refreshed on demand from within Power 
Pivot or Excel. 

In this example, a PivotTable report will be constructed from a Microsoft Access database and two Excel 
files. In the Power Pivot window, click Home, From Other Sources, Microsoft Access to open the Table 
Import Wizard as shown in Figure 64. 

 

Figure 64 – Importing Data from an Access Database 

In the first pane of the wizard, click Browse and then select the desired database, in this case, 
ContosoSales. Click Next to open the second pane of the wizard. Choose Select from a list of tables and 
views to choose the data to import and click Next. Select the following tables: DimChannel, DimDate, 
DimProduct, DimProductSubcategory, DimPromotion, and FactSales. 

If you are unsure which tables contain the data elements that you need, click Preview & Filter, which will 
allow you to see the data within each table. The Preview & Filter pane also allows users to filter the data 
to include just the required records. If you are unsure as to whether you may need data stored in tables 
related to those selected, click Select Related Tables, and Power Pivot will select the related tables 
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automatically. Click Finished to open the final pane of the wizard – the Import Status dialog box – and 
begin the data import. When the data is imported successfully, click Close to display the tables in the 
Power Pivot window as shown in Figure 65. Each table will be displayed on a single tab. Note that the 
FactSales table contains nearly 2.3 million records. 

 

Figure 65 – Populating the Power Pivot Window with Imported Data 

Continue by importing data from two Excel workbooks – DimStores and DimGeography – that contain 
information about the stores and geographical locations in which sales revenue is earned. In the Power 
Pivot window, click Home, From Other Sources, Excel File to open the Table Import Wizard. Browse to 
the location of DimStores, select the file, and then click Open. Make sure to check Use first row as column 
headers. Click Next, Finish, and Close to complete the process. Repeat the process to import 
DimGeography. 

Each imported table is 
on its own tab. 
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Defining Relationships Using Diagram View 
If multiple tables are imported from the same database, and those tables are related in the source 
database, Power Pivot recognizes and maintains those relationships. If, however, data is imported from 
separate data files – for instance, multiple Excel workbooks, multiple databases, or multiple Power 
Queries – or data imported from a database is not already related, relationships must be established 
between the tables in Power Pivot prior to building reports or dashboards. Users can employ a simple, 
click-and-drag process in Diagram View, shown in Figure 66, to build the necessary relationships. 

 

Figure 66 – Diagram View Displays the Relationships among Tables 

As its name implies, Diagram View displays the tables visually like the way tables are displayed and related 
in the Microsoft Query Wizard or Microsoft Access. To open Diagram View, simply click Diagram View on 
the Home tab of the Power Pivot ribbon. In the Diagram View shown in Figure 66, six of the eight tables 
are related because Power Pivot recognized and maintained the relationships on import. The two Excel 
tables imported separately need to be related if the data in those tables are to be used in any reports or 
dashboards based on this Data Model.  

To create relationships in Diagram View, simply click-and-drag a common field from an unrelated table 
and drop it on the common field in the table with which you want to create the relationship. In this case, 
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drag StoreKey from the DimStores table and drop it on StoreKey in the FactSales table and then drag 
GeographyKey from the DimGeography table and drop it on GeographyKey in the DimStores table. Once 
the relationships are established, click a join line to examine or delete the relationship. Note that the 
process creates an inner join between the related tables. To create other types of joins, use Power Query 
to specify the join type – inner, left outer, right outer, or self, etc. This process can be repeated as often 
as necessary to relate all the tables in a Data Model. 

Creating PivotTable Reports with Power Pivot 
Now that the data has been imported and the tables related, it's time to create a PivotTable report. The 
process for creating PivotTables and Pivot Charts using Power Pivot is identical to creating ordinary 
PivotTables and Pivot Charts in Excel. To begin the process, click PivotTable on the Home tab in the Power 
Pivot add-in and then select the type of PivotTable or PivotChart to create. Figure 67 shows a simple 
PivotTable report produced from the Power Pivot data model. 

 

Figure 67 – PivotTable Report Built on 2.3 Million Records Using Power Pivot 

In the PivotTable displayed in Figure 67, the SalesAmount field in the FactSales table was added to the 
Values area of the PivotTable Field List. This created an implicit measure in the Data Model named Sum 
of SalesAmount. To see the measure, click Manage on the Power Pivot tab to open the Data Model. Click 
the FactSales tab and then click Advanced, Show Implicit Measures. Scroll to the right in the FactSales 
table until the SalesAmount column is visible. If the Calculation Area is not visible at the bottom of the 
table, click Home, Calculation Area in the View group. Click on the cell that contains the measure to see 
the formula, Sum of SalesAmount:=SUM('FactSales'[SalesAmount]), in the Formula Bar just below the 
ribbon. Note that the formula simply sums all sales in the table, not the individual amounts that are 
reported in the PivotTable. The amounts seen in the PivotTable result from filter context, which is provided 
by the row and column names in the report. In more sophisticated Data Models, measures are calculated 
explicitly using DAX formulas. 
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Converting PivotTables to Cube Formulas 
The ability to build formal reports with cube functions is one of the significant advantages of using the 
Data Model as a data source. Cube functions were introduced in Excel 2007 to create reports from data 
summarized in SQL Server Analysis Services. Since the Excel Data Model, introduced in Excel 2013, is an 
OLAP cube, these functions are more relevant now than ever. 

An OLAP cube, like the Data Model, contains two types of information – dimensions and measures. 
Dimensions refer to dimensional categories, such as the date or time of sale, the item or type of product 
sold, or the store or region in which the sale was made. Dimensions are composed of hierarchies 
(parent/child levels) with each level containing individual elements or members. Measures refer to 
numeric information that can be summarized or totaled, such as the sales price of an item, the cost of an 
item, or how many were sold. Dimensions give meaning to measures. In other words, it's not enough to 
know total sales if users need sales by store, by item, or by item category. Dimensions provide these 
categorical breakdowns.  

Excel has seven cube functions for creating reports, each identified in the following table. 

Function  Description  

CUBEKPIMEMBER Returns a key performance indicator (KPI) property 

CUBEMEMBER Returns a member from the cube  

CUBEMEMBERPROPERTY Returns the value of a member property from the cube 

CUBERANKEDMEMBER Returns the nth, or ranked, member in a set 

CUBESET Defines a calculated set of members in a cube 

CUBESETCOUNT Returns the number of items in a set 

CUBEVALUE Returns an aggregated value from the cube 

 

To begin the exploration of cube functions, first create a simple PivotTable on the Excel Data Model. In 
this example, the Data Model is built on four related tables – Transactions, Industry, Service, and Dates. 
A simple PivotTable is used to reduce the complexity of the example. Convert the PivotTable to formulas 
by selecting OLAP Tools, Convert to Formulas in the PivotTable Tools, Analyze tab as shown in Figure 68. 
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Figure 68 – Converting a PivotTable to Cube Formulas 

This process converts a PivotTable built on the Excel Data Model into a report using cube functions to 
display specified intersections in the Data Model without impairing the ability of a user to refresh the 
report. Refreshing a report updates the values for any changes that have been made in the underlying 
data. For example, a sales revenue report could be refreshed monthly to display updated sales revenue 
amounts given the transactions that have occurred in the intervening period.  

Make sure to arrange the PivotTable to display the level of detail required before converting it to formulas. 
Note that after conversion, the limitations imposed on PivotTables are removed. For example, users can 
insert rows or columns across the report for summary calculations. This is not possible in a PivotTable. 
Figure 69 displays the report with summarizing calculations for Total Eastern US sales. As the underlying 
data changes over time, the report based on cube formulas can be refreshed just as if it were a PivotTable. 

 

Figure 69 – Reports Based on Cube Formulas Remove PivotTable Limitations 

Rows inserted with formulas to 
calculate Total Eastern US sales. 
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Report authors with access to Power Pivot can create reports directly from the Data Model without first 
creating a PivotTable because they can create explicit measures in Power Pivot. Those without access to 
Power Pivot must use a PivotTable to create implicit measures before creating cube formula reports. For 
example, a Power Pivot user can use a DAX formula (TotalSales:=SUM([Service Rev])) to calculate total 
sales revenue explicitly. 

Introducing Power BI 
Power BI is a set of cloud-based Microsoft tools used in tandem with Microsoft Office Excel to provide end 
users with the ability to summarize large volumes of data quickly, create visualizations of the results, drill 
down on data to see the supporting detail, and share the data in dashboards. You can use the capabilities 
of Power BI to analyze all types of data, including financial, sales, manufacturing, human resources, and 
more. The flexibility of Power BI allows you to create Key Performance Indicators (KPIs) that you can easily 
update and filter to spot trends over time, regions, budgets, or goals.  

Additionally, you can extend the capabilities of Power BI 
with Power Map and Power View, two tools for creating 
powerful and interactive visualizations. Using these tools 
allows you to analyze data in real time, giving you the ability 
to explore data, design interactive reports, and share this 
information in dashboards. 

What Are the Components of Power BI? 
The relationship between Power BI and a desktop installation of Excel with related add-ins can be complex 
and difficult to understand. As mentioned previously, Power BI works with Microsoft Office Excel – more 
specifically, Excel provisioned through Office 365 ProPlus or Office 2013 Professional Plus. With these 
versions of Excel, you also have access to four tools that are related to Power BI, but which are not 
technically components of Power BI: Power Pivot, Power View, Power Maps, and Power Query. Each of 
these four tools is available without subscribing to Power BI. However, subscribing to Power BI adds 
functionality that is not otherwise available with Excel and related add-ins, including BI Sites to share and 
view reports and dashboards, access to BI reports and dashboards on mobile devices, and the ability to 
create natural language queries. 

Table 1, adapted from information published on Microsoft’s website, summarizes the business 
intelligence capabilities of Power BI and related components. 

  

Wrangler Sales
Schedule of Sales and Expenses

For the Years Ended 2012 through 2015
As Of : Tuesday, November 17, 2015

Sales COS Overhead  Profit 
2012 3,457,689$         53,421$            477,265$          2,927,003$       
2013 1,919,057           420,102            462,583            1,036,372         
2014 2,041,016           551,172            467,298            1,022,546         
2015 1,326,315           890,564            530,000            (94,249)             

8,744,077$         1,915,259$       1,937,146$       4,891,672$       

Copyright © 2018 K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises training event is prohibited. 
70



 

 

Feature Capability 
Office 365 ProPlus or 

Office 2013 
Professional Plus 

Power BI for Office 365 

Power Pivot Create data models •  

Power View 
Authoring 
Excel Client viewing 
Excel Web Client viewing 

• 
• 

<10 MB File Size 

 
 

<250MB File Size 

Power Maps 
Authoring 
Excel Client viewing 
Excel Web Client viewing 

• 
• 

N/A 

 
 

N/A 

Power Query 
Public data catalog access 
Corporate data catalog 
access 

• 
 

• 

 
 

• 

BI Sites 
Access to BI sites to 
share/view reports and 
dashboards 

 • 

Scheduled Data 
Refresh 

Scheduled refresh of on-
premises data 

 • 

Data Stewardship Manage and share data 
queries 

 • 

Mobile BI Service HTML5 and Mobile App 
access 

 • 

Natural Language 
Query 

Search based data 
visualizations 

 • 

Table 1 – Power BI Components and Capabilities 

 

How Do I Acquire Power BI? 
The best method of acquiring Power BI will depend on the tools to which you already have access.4  

• If you currently subscribe to either Office 365 E3 or E4, you can acquire Power BI by subscribing 
to the Power BI Add-on. The Power BI Add-on costs $9.99 per month, per user. 
 

• If you subscribe to Office 365 ProPlus or own Office 2013 Professional Plus, but you do not have 
an Office 365 E3 or E4 subscription, you can purchase the Power BI Standalone subscription for 
$17.99 per month, per user. 
 

• If neither of the above applies to you, then you should probably subscribe to an Office 365 E3 or 
E4 plan and choose the Power BI Add-on. The total cost would be $29.99 per month, per user 
for the E3/Power BI combination or $31.99 per month, per user for the E4/Power BI 
combination. 

                                                           
.  
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